WELCOME TO THE WORLD OF LEGO® MINDSTORMS®

Congratulations on your new LEGO® MINDSTORMS® NXT robotics tool set. You now have the power to build and program robots that do what you want!

Dream it, build it
Your MINDSTORMS NXT set enables you to create thousands of robotic inventions. Intelligent robots that see, hear, speak, feel and more. Advanced robots that you can control with your mobile phone. Cool robots that guard your room and do your chores. If you can dream it, you can build it.

Build. Program. Go!
Creating a MINDSTORMS robot is easy. Build the robot using your LEGO elements. Program it using the easy-to-use software and watch your robot come alive. For your first robotic adventure, try out the quick-build model that you can build and program in less than 30 minutes.

Smart technologies
Your MINDSTORMS NXT set features the latest in robotic technology: an advanced 32-bit programmable microcontroller; icon-based drag and drop programming software and interactive challenges; smart sensors and Interactive Servo Motors; wireless Bluetooth and USB connection. In fact all the smart technologies you need to create your dream robot.

MINDSTORMS.com
You are now a part of the worldwide LEGO MINDSTORMS community. Log on to MINDSTORMS.com and get more robotic challenges. Download programs, sound effects and other cool stuff. Share your inventions and exchange tips and tricks with other MINDSTORMS users. www.MINDSTORMS.com is your new robotic hot spot.

Find out more
In this User Guide you can learn more about the technology and the many exciting features in your MINDSTORMS set.

Have fun building your own amazing robots!
The LEGO MINDSTORMS team.
BUILD. PROGRAM. GO!

Build
Build a robot. You can find building instructions in this User Guide, in the software or at www.MINDSTORMS.com. Or you can use your imagination to build your own unique robot.

Program
Program your robot to do what you want. Use the LEGO® MINDSTORMS® NXT Software to make a program. Download the program to the NXT by using the USB cable or the wireless Bluetooth connection.
Quick Start

Use the Quick Start kit to get your first MINDSTORMS experience. In the Quick Start kit you will find everything you need to get off to a great start. It will only take you a few minutes to create your first MINDSTORMS robot, test it, and get a fun reaction.

Go!
Run the program and watch your robot come to life.
NXT TECHNOLOGY OVERVIEW

The NXT
The NXT is an intelligent, computer-controlled LEGO® brick and the brain of the MINDSTORMS® robot.

Touch Sensor
Enables the robot to feel and react to its environment.

Sound Sensor
Enables the robot to hear and react to sound.

Light Sensor
Enables the robot to detect light and color.
**Interactive Servo Motors**

Ensure that the robot moves with precision.

---

**Ultrasonic Sensor**

Enables the robot to see, measure distance to an object, and react to movement.

---

**Standard port settings for sensors and motors**

To make your robot work correctly, the sensors and motors should be connected to specific input and output ports. Here are the standard port settings:

**Input ports**
- Port 1: Touch Sensor
- Port 2: Sound Sensor
- Port 3: Light Sensor
- Port 4: Ultrasonic Sensor

**Output ports**
- Port A: Motor used for an extra function
- Port B: Motor for movement
- Port C: Motor for movement
CONNECTING THE NXT TECHNOLOGY

Connecting motors
To connect a motor to the NXT, use one of the black 6-wire cables. Attach one end of the cable to the motor and the other to one of the NXT's output ports (A, B, or C).

Connecting sensors
To connect a sensor to the NXT, use one of the black 6-wire cables. Attach one end of the cable to the sensor and the other to one of the NXT's input ports (1, 2, 3, or 4).

Downloading and uploading
The USB port and wireless Bluetooth connection let you download and upload data between your computer and the NXT. If your computer has Bluetooth capability, you can download programs to the NXT without using the USB cable. If your computer does not have Bluetooth capability, you must use the USB cable or install a Bluetooth USB dongle on your computer.

NOTE: Read more about wireless Bluetooth communication on page 28.
Connecting the NXT to a PC with a USB cable

Turn on the NXT.

Make sure that the LEGO® MINDSTORMS® NXT Software is installed before connecting your NXT to your PC (see page 38).

Connect the PC and the NXT with the USB cable.
When the PC identifies the NXT it will automatically finalize the installation of the LEGO MINDSTORMS NXT Software.

Connecting the NXT to a Macintosh with a USB cable

Make sure that the LEGO MINDSTORMS NXT Software is installed before connecting your NXT to your Macintosh (see page 39).

Turn on your NXT.
Connect the USB cable to the NXT.
Connect the USB cable to the Macintosh and you’re ready to go.
ABOUT THE NXT

The NXT is the brain of a MINDSTORMS® robot. It’s an intelligent, computer-controlled LEGO® brick that lets a MINDSTORMS robot come alive and perform different operations. Please note that all text on the NXT display is in English.

Motors parts
The NXT has three output ports for attaching motors. To make the motor work, the motors need to be attached to port A, B or C.

Bluetooth icon
The Bluetooth icon shows the current status of any wireless Bluetooth connections. If there is no Bluetooth icon shown, Bluetooth is OFF.

USB icon
When you connect your NXT to a computer with a USB cable, a USB icon will be displayed. If you disconnect the USB cable, the icon will disappear.

USB
USB connected and working fine.

USB connected but not working properly.

Sensor ports
The NXT has four input ports for attaching sensors. The sensors need to be attached to port 1, 2, 3 or 4.
NXT TECHNOLOGY

- **Naming the NXT**
  You can change the name of your NXT by going to the NXT window in the software. This window is accessible from the Controller. NXT names can be at most eight characters long.

- **Battery level**
  The battery icon displays the power level of the NXT. When battery power is low, the battery icon will flash on or off.

- **Running icon**
  When your NXT is turned on, the running icon will spin. If the running icon stops spinning, your NXT has frozen and you will need to reset it (see page 74, Troubleshooting).

- **Loudspeaker**
  Make a program with real sounds and listen to them when you run the program.

- **NXT buttons**
  Orange button: Go/Enter
  Light grey arrows: Used for moving left and right in the NXT menu.
  Dark grey button: Clear/Go back

- **Turning off your NXT**
  Push the dark grey button repeatedly until you see the screen on the right.
  Push the orange button to turn off your NXT.
  Push the dark grey button to go back to the main menu.

- **NXT display options**
  Your NXT has many other cool features. Read more about them on the following pages.

---

**Technical specifications**

- 32-bit ARM7 microcontroller
- 256 Kbytes FLASH, 64 Kbytes RAM
- 8-bit AVR microcontroller
- 4 Kbytes FLASH, 512 Byte RAM
- Bluetooth wireless communication (Bluetooth Class II V2.0 compliant)
- USB full-speed port (12 Mbits)
- 4 input ports, 6-wire cable digital platform (One port includes an IEC 61158 Type 4/EN 50 170 compliant expansion port for future use)
- 3 output ports, 6-wire cable digital platform
- 100 x 64 pixel LCD graphical display
- Loudspeaker – 8 kHz sound quality. Sound channel with 8-bit resolution and 2-16 KHz sample rate.
- Power source: 6 AA batteries.
INSTALLING BATTERIES IN YOUR NXT

Battery type
- The NXT requires 6 AA/LR6 batteries to function properly.
- Alkaline batteries are recommended.
- Rechargeable batteries can be used, but the NXT's power may be reduced, making the motors turn more slowly.

Low battery power
When battery power is low, this icon will pop up on the NXT's display screen.

Important!
- Never mix different types of batteries in the NXT.
- Always remove batteries prior to long-term storage.
- Promptly remove depleted batteries from the NXT.
- Only recharge batteries under adult supervision.
- Never attempt to recharge non-rechargeable batteries.
NXT MAIN MENU

My Files

The My Files submenu will let you see all of the programs you have made on the NXT or downloaded from your computer.

Software files
Software files - programs you have downloaded from your computer

NXT files
NXT files - programs you have made on the NXT

Sound files

Files will automatically be placed in the appropriate subfolders. When you download a program including a sound file to your NXT, the program will be placed under Software files, while the sound data will be placed under Sound files. You can send files to other NXTs. Read more about this on page 36.
You don’t need a computer to program your robot. Using the NXT Program submenu, you can make thousands of different programs without your computer.

Try this simple program and see how easy it is:

Make the robot go back and forth when its Touch Sensor is pressed. First, the robot will move forward until the Touch Sensor is pressed, and then it will move backwards. When its Touch Sensor is pressed again, the robot will move forward once again. This will continue indefinitely until you stop the program.

Make sure that your sensors and motors are connected to the right ports.

1. Select Forward. Use the arrow buttons to move through the choices and then press the orange button [Enter] to make your selection.

2. Select Touch.

3. Select Backward.
Select Touch again.

Now select if you want the program to Loop. This means that the program will run again and again until you switch off the NXT. For our little test, select Loop.

Now you can run your program. Simply select Run!

Try these programs as well:

1. 

2. 

3. 

4.
Try Me

The Try Me submenu lets you test your sensors and motors in a fun way:

Connect the sensors and motors to the appropriate ports on the NXT. Important: Use the standard settings for the ports as explained on page 7.

Select a program.

When you press the orange [Enter] button, you will get some fun reactions from the sensors and motors.

Explore other Try Me programs to get some more fun sounds, to display images and to experience different motor reactions.

You can always delete these Try Me files again using the Settings submenu.
The View submenu lets you carry out a quick test of your sensors and motors, observing real-time data from each unit.

Connect the sensor or motor you would like to test to the NXT - the View submenu will help you select the right port or check standard settings on page 7. Select View on the NXT’s display.

Select the icon of the sensor or motor you would like to test. You can only get readings from one sensor or motor at a time.

Select the port that the sensor or motor is attached to.

The data from the sensor or motor will appear on the display.
Settings

The Settings submenu lets you adjust the NXT's settings including its speaker volume or the Sleep mode setting. This submenu will also let you delete programs that have been stored in the NXT's memory.

Sleep mode: You can set the NXT to turn itself off after 2, 5, 10, 30 or 60 minutes of inactivity (time when it's not in use). You can also select the Never setting so that it remains on indefinitely (until you turn it off). Please be aware that the Never setting will drain your batteries more quickly.

Change volume: Here you can adjust the volume of the NXT's speakers.

Delete all programs: You are able to delete all downloaded programs in the 3 sub folders: Software files, NXT files, Sound files, from the Settings submenu.
Bluetooth

The Bluetooth submenu will let you make a wireless connection between your NXT and other Bluetooth devices [like other NXTs, mobile phones, and computers]. You can use a wireless Bluetooth connection to send programs to other NXTs, to download programs from your own computer without using a USB cable, and lots of other cool things, such as using your mobile phone to control your robot! Read more about wireless Bluetooth communications on pages 28.
The Touch Sensor gives your robot a sense of touch. The Touch Sensor detects when it is being pressed by something and when it is released again.

**Pressed**  **Released**  **Bumped**

**Suggestions for use**
You can use the Touch Sensor to make your robot pick up things: a robotic arm equipped with a Touch Sensor lets the robot know whether or not there is something in its arm to grab. Or you can use a Touch Sensor to make your robot act on a command. For example, by pressing the Touch Sensor you can make your robot walk, talk, close a door, or turn on your TV.

**Try Me**

**Test it!**
Test the Touch Sensor and get a fun reaction.
Connect a Touch Sensor to port 1 of your NXT and select the Try-Touch program in the Try Me submenu on the NXT’s display.
SOUND SENSOR

The Sound Sensor makes your robot hear!

The Sound Sensor can detect both decibels (dB) and adjusted decibels (dBA). A decibel is a measurement of sound pressure.

dBA: In detecting adjusted decibels, the sensitivity of the sensor is adapted to the sensitivity of the human ear. In other words, these are sounds that your ears are able to hear.

dB: In detecting standard (unadjusted) decibels, all sounds are measured with equal sensitivity. Thus, these sounds may include some that are too high or low for the human ear to hear.

The Sound Sensor can measure sound pressure levels up to 90 dB - about the level of a lawnmower. Sound pressure levels are extremely complicated, so the Sound Sensor readings on the MINDSTORMS® NXT are displayed in percent (%). To give some comparative examples: 4-5% is like a silent living room, 5-10% would be the reading you get from someone talking some distance away, 10-30% is normal conversation close to the sensor or music played at a normal level. And you will record readings of 30-100% from people shouting and music played at high volumes.

Suggestions for use
You can use the Sound Sensor to make a sound controlled robot. Talk to your robot and it will answer you back. Clap your hands and the robot can pick up things and bring them to you.

Test it!
Test the Sound Sensor’s ability to read sound volume:
Connect the Sound Sensor to the NXT.

Select the View submenu on the NXT’s display. Select the Sound Sensor icon and the port where you have connected the sensor.

Make some sounds into the Sound Sensor and watch the readings displayed on the NXT. Use the sensor to read some sounds around you. How loud do your parents speak? How loud is your front doorbell?

Select the Try Me submenu on the NXT’s display and test your Sound Sensor. You’ll get a fun reaction.
LIGHT SENSOR

The Light Sensor is one of the two sensors that give your robot vision (the Ultrasonic Sensor is the other). The Light Sensor enables your robot to distinguish between light and dark. It can read the light intensity in a room and measure the light intensity of colored surfaces.

Suggestions for use

You can use the Light Sensor to make a burglar alarm robot: when an intruder turns on the light in your room, the robot can react to defend your property. You can also use the Light Sensor to make a line-following robot or a robot that can sort things by color.

Detecting ambient [surrounding] light

Test the Light Sensor’s ability to read ambient light by measuring the light level in different locations of the room. For example, first hold the sensor against the window. Then hold it under the table. Watch how the readings differ.

Test it!

You can test the Light Sensor in different ways:
Connect the Light Sensor to the NXT.

1. Select the View submenu on the NXT's display. Select the Light Sensor icon and the port where you have connected the sensor.
2. Hold the Light Sensor up to the different colors on the test pad and see the different readings.
3. Select the Try Me submenu on the NXT's display and test your Light Sensor. You'll get a fun reaction.
ULTRASONIC SENSOR

The Ultrasonic Sensor is the other sensor that gives your robot vision. The Ultrasonic Sensor enables the robot to see and detect objects. You can also use it to make your robot avoid obstacles, sense and measure distance, and detect movement.

The Ultrasonic Sensor measures distance in centimeters and inches on the NXT. It is able to measure distances from 0 to 255 centimeters with a precision of +/-3 cm.

The Ultrasonic Sensor uses the same scientific principle as bats: it measures distance by calculating the time it takes for a sound wave to hit an object and return - just like an echo.

Large-sized objects with hard surfaces return the best readings. Objects made of soft fabric or that are curved (like a ball) or are very thin or small can be difficult for the sensor to detect.

Note that two or more Ultrasonic Sensors operating in the same room may interfere with each other’s readings.

Test it!
Test the Ultrasonic Sensor’s ability to measure distance:
Connect the Ultrasonic Sensor to the NXT.
Select the View submenu in the NXT display.

Select the Ultrasonic Sensor icon and the part where you’ve connected the sensor.

Measure the distance to an object. For example, move your hand closer to the sensor and watch the readings change.

Select the Try Me submenu on the NXT’s display and test your Ultrasonic Sensor. You’ll get a fun reaction.

Suggestions for use
You can use the Ultrasonic Sensor in many different ways. Program a robot to sneak around the house without it bumping into things. Or make an advanced burglar alarm robot that reacts to movement as well as light. Your Scorpion robot “stings” if you come to close.
INTERACTIVE SERVO MOTORS

The three Servo Motors give your robot the ability to move. If you use the Move block in the software to program your motors, the two motors will automatically synchronize, so that your robot will move in a straight line.

Built-in Rotation Sensor
Each motor has a built-in Rotation Sensor. This lets you control your robot’s movements precisely. The Rotation Sensor measures motor rotations in degrees or full rotations (accuracy of +/- one degree). One rotation is equal to 360 degrees, so if you set a motor to turn 180 degrees, its output shaft will make half a turn.

Test it!
Test the built-in Rotation Sensor’s ability to measure distance:
Connect a motor to the NXT.
Select the View submenu in the NXT’s display.

Select the Motor Rotations icon. Select the port where you have connected the motor.

Now attach a wheel to the motor and measure the rotations as you roll the wheel along the floor.

Select the Try Me submenu on the NXT’s display and test your motors. You’ll get a fun reaction.
1. The motor
2. Tachometer (Rotation Sensor)
3. Built-in gearing
Bluetooth is a technology that makes it possible to send and receive data without using wires or cables. Using Bluetooth, you can exchange programs between your NXT and other NXTs. Or you can establish a wireless connection between your computer and your robot and try out programs instantly— even with your robot on the other side of the room!

If you have a mobile phone with Bluetooth capability, you can use it to control your robot. You might even be able to use it as an advanced sensor, like a camera sensor. Visit www.MINISTORMS.com/bluetooth for more information on mobile phone requirements.
CONNECTING YOUR NXT TO A COMPUTER

Before you try to set up a wireless Bluetooth connection, make sure that your computer has Bluetooth capability.

If your computer does not have built-in Bluetooth capability, you must use a Bluetooth USB dongle. Make sure that you use the right type of Bluetooth USB dongle. Read more about the different types of Bluetooth USB dongles to use at www.MINOSTORMS.com/bluetooth

MAKING THE CONNECTION TO A PC

1

Make sure that your NXT is turned on. Also make sure that you have Bluetooth set to On and that your NXT is set to be Visible (read how in the Bluetooth submenu on the NXT on page 34). Also make sure that Bluetooth is installed and enabled on your computer. See your computer’s and Bluetooth USB dongle’s instruction manuals for details.

Find the Controller at the lower right corner of the work area in the software. Click on the NXT window button (the one at the upper left) and the NXT window will open.
Click Scan. Your computer will automatically search for Bluetooth devices.

After a short interval, a list of available Bluetooth devices will appear in the window on the computer screen. Select the device you want to connect to and click the Connect button.

When you connect to a device for the first time, the Enter Passkey window will pop up. Enter the passkey to use with this device (the default passkey is 1234) and click OK.
NXT TECHNOLOGY

Enter the passkey on your NXT and confirm the connection by pushing the orange [Enter] button. If you have chosen the default passkey, just click the orange [Enter] button.

In the NXT window, the status of your NXT has now changed from Available to Connected. Your NXT and computer are now connected and can share data.

MAKING THE CONNECTION TO A MACINTOSH

1

Make sure that your NXT is turned on. Also make sure that you have Bluetooth set to On and that your NXT is set to be Visible (read how in the Bluetooth sub-menu on the NXT on page 34). Also make sure that Bluetooth is installed and enabled on your computer. See your computer's and Bluetooth USB dongle's instruction manuals for details.

Find the Controller at the lower right corner of the work area in the software. Click on the NXT window button (the one at the upper left) and the NXT window will open.
Click Scan. The Bluetooth device window will pop up on the screen.

A list of Bluetooth devices will appear in the Select Bluetooth Device window on the screen. Select the device you want to connect to and click the Select button.

The NXT that you want to connect to appears in the NXT window as available. Click the Connect button.
The Pair with a Bluetooth Device window pops up. Select the NXT, Click Pair.

When you connect to a device for the first time, a Passkey window will pop up. Enter the passkey to use with this device (the default passkey is 1234) and click OK.

Enter the passkey on your NXT and confirm the connection by pushing the orange [Enter] button. If you have chosen the default passkey, just click the orange [Enter] button.

Your Macintosh and NXT are now connected and can share data.
BLUETOOTH SUBMENU ON NXT

Bluetooth
Select the Bluetooth submenu on the NXT display.

Search
Search for other Bluetooth devices. After you have chosen the Search icon, your NXT will automatically start to search for other Bluetooth devices that it can connect to.

My Contacts
You can see all of your trusted Bluetooth contacts in My Contacts. These contacts can automatically connect and send data to your NXT without using a passkey. To add a new contact to the list, you must have been connected to the contact before. Devices which you have been connected to, will automatically be added to the list in My Contacts.

Connections
This item displays your current connections. You can connect your NXT to three devices at the same time (on Line 1, 2 and 3), while one device can connect to you (on Line 0). Note, however, that while you can be “connected” to up to three devices, you can only “communicate” with one device at a time.
You can also view the connection status in the NXT window in the software. There you can change the name of your NXT, check battery and memory levels, and delete programs on your NXT.

Check the connection status in the icon bar at the top of the NXT’s display. If there is no Bluetooth icon shown, Bluetooth is OFF.

⚙️ Bluetooth is ON but your NXT is not visible to other Bluetooth devices.
NSMutable Bluetooth is ON and your NXT is visible to other Bluetooth devices.
鼒 Bluetooth is ON and your NXT is connected to a Bluetooth device.

Visibility
Use the Visible option to make your NXT visible or invisible to other Bluetooth devices when they do a Bluetooth search.

Passkey
The Passkey ensures that only Bluetooth devices approved by you can connect to your NXT. Whenever you connect to a Bluetooth device for the first time using your NXT, you will be asked for a passkey. Select the preset passkey 1234 or make up your own code. Other Bluetooth devices must know your passkey in order to confirm a connection with your NXT.

On/Off
You can turn Bluetooth functionality on or off. If you turn Bluetooth off, you will not be able to send or receive data over Bluetooth. To save battery power, turn off the Bluetooth function when it is not in use.

Note! Bluetooth is turned off by default.
CONNECTING YOUR NXT TO ANOTHER NXT

1. Select the Bluetooth submenu on the NXT’s display.

2. Select the Search icon to search for other Bluetooth devices. Your NXT will automatically search for Bluetooth devices.

3. Depending on how many devices are detected in the area, a list will pop up on the NXT’s display after a few seconds.

4. Select the device you want to connect to. Remember that you can give each NXT a unique name—see Naming the NXT on page 11.

5. Select which of the three lines of communication you want the connection to be on (1, 2 or 3). You can connect your NXT to three different devices at the same time.

6. If you connect to a device for the first time, your NXT will ask for a passkey. Just press enter to use the default passkey 1234 or make up your own code. The other Bluetooth device must know your passkey in order to confirm the connection. This means that the two NXTs need to enter the same passkey in order to connect.

7. If you want to connect your NXT to more than one Bluetooth device, go to the My Contacts submenu to select a trusted contact or start a new search.
Connecting to more than one NXT
You can connect up to three NXTs or other Bluetooth devices to your NXT at the same time. However, you can only communicate with one device at a time.

Sending files from NXT to NXT
It’s easy to send programs from your NXT to another NXT:

1. Make sure that your NXT is connected to the NXT to which you want to send the program (see page 36, Connecting your NXT to another NXT).
   Select the My Files submenu in the NXT’s display and select the program you want to send.
2. Select Send.
   Select which of the connected devices you want the program to be sent to (Line 1, 2 or 3).
   Your NXT will now send the file.

Connecting your NXT to a mobile phone
If you have a mobile phone with Bluetooth capability, you can use it with your LEGO® MINDSTORMS® NXT set. Go to www.MINDSTORMS.com/bluetooth for more information on mobile phone requirements. Here you can also download the MINDSTORMS NXT Bluetooth connection program for your mobile phone and get additional information on how to connect your NXT to mobile phones.
SYSTEM REQUIREMENTS

Before installing the LEGO® MINDSTORMS® NXT Software, you must make sure that your computer meets the following minimum system requirements:

**Windows**
- Intel® Pentium® processor or compatible, 800 MHz minimum
- Windows XP Professional or Home Edition with Service Pack 2
- 256MB of RAM minimum
- Up to 300MB of available hard disk space
- XGA display (1024x768)
- 1 available USB port
- CD-ROM drive
- Compatible Bluetooth adapter (optional)*

**Macintosh**
- PowerPC® G3, G4, G5 processor, 600 MHz minimum
- Apple Mac OS X v. 10.3.9 or 10.4
- 256MB of RAM minimum
- Up to 300MB of available hard disk space
- XGA display (1024x768)
- 1 available USB port
- CD-ROM drive
- Compatible Bluetooth adapter (optional)*

*Supported Bluetooth software include Widcomm® Bluetooth for Windows (newer than v. 1.4.2.10 SP5), and the Bluetooth stacks included in Microsoft Windows XP with Service Pack 2 and Apple Mac OS X (10.3.9 and 10.4). For more details on compatible Bluetooth adapters, see www.MINDSTORMS.com/bluetooth.

INSTALLING THE SOFTWARE

**Microsoft Windows**
Exit all open programs.
Insert the CD-ROM.
If the CD-ROM does not run automatically:
- click the Start button (at the bottom left-hand corner of your screen)
- click Run
- type d:\autorun.exe (where d:\ is your CD drive)
Select your preferred language.
Follow the on-screen instructions.

Apple Macintosh
Exit all open programs.
Insert the CD-ROM.

Open the “LEGO MINDSTORMS NXT” CD-ROM and double-click Install.
Select your preferred language.
Follow the on-screen instructions.

When the installation procedure is complete, click Finish. You are now ready to use the LEGO MINDSTORMS NXT Software and create programs for cool robotic inventions.
YOUR FIRST PROGRAM

This simple program will make the NXT play a sound file. It will help you understand how to connect your computer to the NXT.

1. Start the software on your PC or Macintosh by double-clicking the program icon.

2. Type in the name of your first program, or just click on Go!

3. First, click on the Sound block icon in the programming palette.
Drag a Sound block and drop it to the right of the Starting point in the work area. Your program is now ready to download and run.

Make sure you turn on your NXT and connect the USB cable to both your computer and the NXT (see page 8, Connecting the NXT technology).

Locate the Controller in the lower right corner of the work area. Click Download and run (the central button) and listen to what happens.

Congratulations, you have completed your first program!
SOFTWARE USER INTERFACE

A quick overview

1. Robo Center
2. My Portal
3. Tool bar
4. Work area
5. Little help window
6. Work area map
7. Programming palette
8. Configuration panel
9. Controller
10. NXT window
SOFTWARE

1. Robo Center window
   Here you can find building and programming instructions for four cool models.

2. My Portal
   Here you can access www.MINDSTORMS.com while programming your robots.
   You can get more robotic challenges and download programs, sound effects and other cool stuff.

3. The toolbar
   The toolbar includes the most frequently used commands from the menu bar in an easy-to-reach location.

4. The work area
   This is the space on the screen where programming takes place. Drag programming blocks from the
   programming palette to the work area and attach the blocks to the sequence beam.

5. Little help window
   Here you can always get help if needed.

6. The work area map
   Use the pan tool on the toolbar to move around the work area – and use the work area map (tab in the
   lower right corner) to get an overview.

7. The programming palette
   The programming palette contains all of the programming blocks you will need to create your
   programs. The tabs at the bottom of the palette let you switch between the common palette (containing
   the most frequently used blocks), the complete palette (containing all of the blocks), and the custom
   palette (containing blocks that you download or create yourself).

8. The configuration panel
   Each programming block has a configuration panel that lets you customize the block for the specific
   input and output that you want.

9. The Controller
   The five buttons on the Controller let you download programs (or parts of programs) from your
   computer to the NXT. With the Controller you can also change the settings of your NXT.

10. The NXT window
    This pop-up window will give you information about your NXT's memory and communications settings.
SOFTWARE

THE ROBO CENTER

In the Robo Center you will find different robot models that you can build and program to do what you want.

Start by selecting a robot model to build and program. We recommend that you start with the Tribot as it is a continuation of the Quick Start model included in the box.

Follow the on-screen building and programming instructions – or solve the challenge on your own.
The programming palette contains all of the programming blocks you will need to create your programs. Each programming block determines how your robot acts or reacts. By combining blocks in sequence, you can create programs that will make your robot come to life.

When you have finished creating your program, download it to the NXT and run it.

Remember to turn on and connect your NXT before downloading a program.
Common palette
To simplify its use, the programming palette has been divided into three palette groupings: the common palette (containing the most used blocks), the complete palette (containing all of the programming blocks), and the custom palette (containing blocks you download or create yourself).

We recommend that you to start with the blocks in the common palette. You should be able to finish all of the starter challenges in the Robo Center with just these blocks. The software’s help area has more information about the rest of the programming blocks when you are ready to move on.

Move block
This block controls the robot’s motors and synchronizes its movements. Use this block to set your robot to go forwards or backwards in a straight line or to turn by following a curve.

Record/Play block
This block lets you record a physical movement with your robot and then play back the recorded movement elsewhere in the program.

Sound block
Use this block to play a sound file or a single tone. To compose a melody of tones, arrange several sound blocks in a row.

Wait block
This block lets your robot sense its environment for a specific condition before it continues with the program. For example, use the Wait block to make the robot wait for a specific sound, touch or time, before it moves on with the program.

Loop block
Use this block if you want your robot to do the same thing again and again. For example, make your robot move forwards and backwards continuously until the Touch Sensor is pressed.

Switch block
This block lets your robot make its own decisions, such as going left when it hears a loud noise and going right when it hears a softer noise.
SOFTWARE

THE CONFIGURATION PANEL

Each programming block has a configuration panel that lets you adjust the settings of the block for the specific actions that you want. When a block is selected in the work area, its configuration panel will be visible at the bottom of the screen.

By changing the parameters on each configuration panel, you can change how a particular block will behave. For example, to make your robot move faster, you can change the Power property on the Move block’s configuration panel.

THE CONTROLLER

The five buttons on the Controller communicate from your computer to the NXT:

- The NXT window button gives you access to the NXT’s memory and communications settings.
- The Download button downloads the program to the NXT. You can then run the program from the NXT.
- The Download and run button downloads a program to the NXT and then starts running the program.
- The Stop button stops a running program.
- The Download and run selected button downloads and runs just a piece of your program’s code (e.g., a single block or just a few blocks). Select the blocks you want to test and click on the Download and run selected button. You will then be able to see how the small sequence of your program performs on the NXT without having to download the whole program.
ELEMENT OVERVIEW

These are the LEGO® bricks in the MINDSTORMS® NXT set #8527.
TEST PAD

Test all your models on this test pad.

This is the starting point on the pad.
LABELS

Use these labels to decorate your robots.

You can use these labels to stick around both ends of a cable, to make sure the cable is connected to the right port.
TROUBLESHOOTING

Resetting the NXT
If the running icon stops spinning, your NXT has frozen
and you will need to reset it. Follow these steps to reset your NXT:

Make sure that your NXT is turned on.
Push the reset button that is located on the back of your NXT in the LEGO® Technic hole in the upper left corner. Use, for example, an unfolded paperclip to press the button.
If you press the reset button for more than 4 seconds you will need to update the firmware (see below).

Updating the firmware in the NXT from your computer
Go to Tools > Update NXT Firmware.

Make sure that your NXT is turned on.
Note! If you have just reset your NXT (see above) the display will not show anything. A ticking sound will tell whether it is turned on or not.
Make sure that your NXT and computer are connected with the USB cable.
Go to the Tools pull-down menu in the software’s menu bar and select Update NXT Firmware.
Select the firmware you want to update. Click download. (Note! The Windows 'Found new hardware wizard' will pop up the first time you update your firmware. Complete the wizard by following the on-screen instruction before you continue.)

For other types of troubleshooting, go to www.MINDSTORMS.com/support

FCC approval:
Model: MINDSTORMS NXT  Fcc Id: NP1S37BB

This device complies with Part 15 of the FCC Rules. Operation is subject to the following conditions:

1. This device may not cause harmful interference.
2. This device must accept any interference received including interference that may cause undesired operation.

Warning:
Changes or modifications to this unit not expressly approved by the party responsible for compliance could void the user's authority to operate the equipment.

NOTE:
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

Hereby LEGO Company declares that MINDSTORMS NXT (8527) is in compliance with the essential requirements and other relevant provisions of Directive 1999/5/E.